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ABSTRACT

In the summer of 2018, an outbreak of Phylonorycter nipigon, commonly known
as the balsam poplar leaf blotch miner, was 1dentified on the Lakehead University
campus m Thunder Bay, Ontario. All balsam poplar and trembling aspen trees in the
study area were affected. Leaf blotch mines created by the larvae of this species were

present on nearly 100% of leaves, thereby prompting this study.

This study investigated leaf blotch mine counts and frequency distributions, leaf
surface areas and two methods of measuring them It was determuned that leaf blotch
mune frequency distributions follow a poisson-like pattern, and that a linear relationship
exists between leaf surface area (cm?) and number of leaf blotch mines present on a leaf
Although balsam poplar has a significantly higher average leaf area (cm?) than trembling

aspen, its leaves did not have a sigmficantly larger average number of leaf blotch mines.
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INTRODUCTION

An epidemuc of Phyllonorycter nipigon (Freeman), known by the common name
balsam poplar leaf blotch miner, occurred in the Thunder bay area mn the summer of
2018. P. nipigon 15 a lepidopteran insect belonging to the fanuly Gracillarndae. Larvae
feed between the upper and lower epidermis of leaves on trees belonging to the
Salicaceae fanmly - most commonly balsam poplar (Populus balsamifera) and trembling
aspen (Populus tremuloides) (Davis 2001). The full extent of the outbreak of P. nipigon
m Northwestern Ontario has yet to be determined, though during the summer of 2018 1t
was observed that nearly 100% of balsam poplar and trembling aspen trees <20 m in
height displayed leaf blotch mines produced by this insect. The affected area mcluded
the Lakehead Umiversity Campus in Thunder Bay, Ontario and was observed as far west
as Dryden, Ontano, and reaching south to the U.S border (Henne, D. personal

observation).

Through counting blotches - or mines - on randomly selected leaves 1t was
determined whether or not a relationship exists between leaf surface area (cm?) and the
number of leaf blotch mines present on a leaf. Distribution of leaf blotch mines on both
balsam poplar and trembling aspen were investigated, comparing tree species leaf areas
and number of mines present on samples collected. Tools used to measure the surface
area of uregular shapes were evaluated for accuracy and effectiveness for the purpose of

leaf area measurement and relationship to number of leaf blotch mines.



LITERATURE REVIEW
HOSTS

Balsam poplar, Populus balsamifera, and trembling aspen, Populus tremuloides,
are two species of trees commonly found across North America and in the boreal forest
of Ontano (Perala 1990, Zasada 1990). The wood of these trees 1s used in light frame
construction, boxes, crates and pallets, as well as veneer, plywood and other engineered
wood products. As such, 1t 1s important to understand potential threats to these tree
species and what effects these threats might have on forest stands and wood supply. It 1s
known that several species of leaf blotch miner are present in the boreal forest and feed
on balsam poplar, trembling aspen, and other members of the Salicaceae fanmly (Hopkin

1996).
LEAF MINERS

Generally, a leaf nuner 1s the larva of an insect that lives in and feeds on the
tissue between the upper and lower epidermus of leaves. These larvae most commonly
belong to the order Lepidoptera (moths and butterflies), though other known leaf nuners
can be sawflies (Symphyta - Hymenoptera), common flies (Diptera) and some beetles
(Coleoptera) (Cranshaw 1993). Damage caused from these insects 1s commonly referred
to as a mune — which 1s the feeding channel inside the parenchyma or epidernus tissue of
a leaf belonging to the host plant. In these feeding channels the outer walls will remain
undamaged, shutting off the mine from the outside and providing both a feeding and

living area for the larva (Hering 1951). Leaf mines can fall under two categories: linear



mines (ophionome mune), and blotch mines (stigmatonome mine). Larva of species
creating a linear nine will move and feed in one direction only, continually moving
forwards (Figure 1). In contrast, blotch miming larvae will feed in several directions
with no apparent system, creating a large ‘blotch’ that covers this excavated area

(Hering 1951).

Figure 1 - Linear vs blotch mines Source: Henng (19531}

The Genus Phyllonorycter

The poplar leaf blotch muners in question belong to the genus Phyllonorycter.
Members of this genus produce blotch mines and are present across much of
northwestern Ontario. For example, P. salicifolela, P. apparella, and P. nipigon are a
few that can be found m our area (Biggs 1995). Historical outbreaks by Phyllonorycter

spp. leafminers in Ontario were reviewed in annual documents compiled by Natural



Resources Canada and the Canadian Forest Service. These forest health reports are
compiled from annual surveys and published the following year. Forest health condition
reports suggest that almost every year there 1s an outbreak of leafminers in Northwestern

Ontario, though these outbreaks may vary in size (Biggs 2002).

Source: Dawis (2001)

Figure 2 - Distnbution of P. nipigon in North America



Phyllonorycter nipigon

The balsam poplar leaf blotch miner, P. nipigon was 1dentified as the species
responsible for widespread damage on poplar trees in the summer of 2018. Adult
females of this insect deposit eggs 1 the epidernus of a leaf belonging to the host
species (either balsam poplar or trembling aspen) where the larva feeds, eventually
creating a blotch type mine. This nune serves as a home for the larva, providing both
food and shelter. The larva will pupate inside the mine and emerge as an adult moth
(Davis 2001). Ongmally discovered in 1970 and described as Lithocolletis nipigon
(Freeman), P. nipigon 1s a tiny moth with wings roughly 4 mm long. P. nipigon 1s
widely distributed across North America, from Ontanio to Alaska, and as far south as
Colorado and the Sierra Nevada Mountains in Califormia. The range of P. nipigon in

Ontario 1s generally west of the Nipigon River (Figure 2).

A detailed description of the external anatomy and taxonomucally important
structures of P. nipigon was compiled by Davis (2001) and 1s summanzed below. Eggs
laid by adult female moths are roughly 0.324 mm long, 0.228 mm wide and 0.12 mm
deep. Upper surfaces of eggs are reticulate and lacking micropapillae. Edges have a
slightly less developed circumferential fringe and a maximum width of 0.28 mm_ The
eggs will have 2-4 micropyles and are surrounded by 9-10 cellular partitions (Davis
2001). Phyllonorycter species have been found to lay between 11-33 eggs per female
(Bagdavaze 1963), with some averaging as much as 102 eggs (Baumgartner 1981). It
has been suggested that this vaniation could result from the availability of carbohydrates

to ovipositing females (LeRoux 1971).



After the egps hatch there are several instars that are categonized as either sap
feeding (1nstars 1-3) or tissue feeding (instars 4-5). Sap feeding instars have strongly
depressed bodies with a maximum length of 3 4 mm and width of 0.6 mm. Here, the
larvae can be described as having a head with a maximum width of 0.3 mm, greatly
depressed and triangular. Setae are less present and 3 pairs of stemma are present in a
widely spread lateral row. Six pairs of cramal setae remain, with one pair dorsally and
five pairs laterally. The labrum 1s bilobed and less than 0.4 of the width of the head with
a serrated margin containing 7-9 serrations per lobed. Mandibles are large and flat with
three elongated acute cusps and one small cusp. The labium 1s described as smooth with
the anterior margin excavate at middle and the spinneret 1s absent, as are the maxillary
and labial palp1. The hypopharynx 1s broad and densely covered with small spines along
the anterior margin, with the margin being slightly incised at the nuddle. Antennae are
reduced, 3-segmented with numerous short basiconic sensilla (Davis 2001). Bodies of
sap feeding instars (1-3) generally lack setae except for the lateral to dorsal and ventral
plates. Legs, prolegs, and crochets are absent and paired ambulatory callosities can be

found both dorsally and ventrically (Figure 3).

Source: Dawvis (2001)

Figure 3 - P. nipigon larva at third instar (sap feeding): 94, head, dorsal view (60 um); 93, labnumm, dorsal view (38
um); 96, head, ventral view (60 um); 98, antenna, ventral view (20 um); 99, antenna, dorsal view (8.6 um); 100,
anteroventral view of mouthparts (38 um); 101, anterior view of mouthparts (38 um); 102, dorsal ambulatory callosity
of prothorax (30 umy); 103, ventral ambulatory callosity of prothorax (27 umy); 104, ambulatory callosity of abdominal
sternum 4 (17.6 um); 105, abdominal segments 9, 10, dorsal view (86 um).



Tissue feeding instars (4-5) have heads with a maximum width of 0.4 mm. Heads
are almost round with full mouthparts present. The frons 1s elongate and roughly 0.85x
the distance to the epicramal notch. The ecdysial line ternunates near epicramal notch.
Chaetotaxy 1s relatively complete and all three setae are present. Three stemma are
present and antennae are moderately long. There are three pairs of epipharyngeal spines
present, lateral spine slightly reduced, with several secondary spines covering the inner
venfral pennmeter of the labrum. The mandible has three large median cusps, along with
one smaller lateral and one smaller mesal cusp. There 1s one single mandibular seta
present. The spinneret 1s a relatively short and stout tube with fleshy, strongly bifurcate
lobe arising from ventral apex. The labial palpus has a relatively long basal segment
bearing one short sensillum and a small globose apical segment bearing a longer

sensillum apically (Davis 2001).

Source: Davis (2001)

Figure 4 — P. nipigon larva at fifth instar (tissue feeding): : 106, head, dorsal view (75 um}; 107, ventral view of head,
thoracic segments 1.2 (0.27 mm); 108, head, ventral view (120 um); 109, detail of labium and hypopharyngeal spines
in Figure 108 (75 um); 110, labial palpi and spinneret (25 um); 111, antenna, anterodorsal view (136 um); 112,
maxilla, anteroventral view (13 um); 113, proleg of abdominal segment 4 (30 um); 114, abdominal segments 9, 10,
dorsal view (176 um); 115, lateral view of Figure 114 (200 um}; 116, ventral view of Figure 114 (120 um); 117, anal
proleg (30 um).



The thorax of tissue-feeding instars (4-5) 1s described as having an unpigmented
mdistinct, and relatively smooth pronotal plate with legs well developed, having widely
spread and separated coxae. The pretarsal claw 1s strongly curved and has a relatively
large and blunt axillary spine. The abdomen has triangular dark brown and rugose dorsal
plates with 19 pairs of primary setae. Crochets with one or two anterior rows of 5-7
hooks and a single posterior row of 5-6 hooks. The anal plate has four pairs of setae, and
anal crochets containing 30-34 hooks arranged in two wregular, circular rows (Davis

2001).

Pupae (Figure 5) reach a maximum length of 5 mm and a width of 0.9 mm. The
vertex has a triangular cocoon cutter. The forewings and antennae extend to the caudal
margin of abdominal section AS. Hindleg extends to A7. Dorsum of A2-AS8 1s almost

completely covered with densely pack short and scattered spines.
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Source: Dawis (2001)
Figure 5 - P. nipigon pupa: 126, ventral view (0.5 mm}); 127, lateral view (AC = accessory cremaster, scale: (. 5mm)



Adult moths (Figure 6) have forewings measuning 3 4-4 4 mm in length. Moths
are small and slender with reddish brown forewings having 4-5 highly vanable white
bands. Male genitalia have symmetrical valvae that gradually taper to a nearly straight,
shightly downcurved acuminate apex. The head has a rough vertex with a mrxture of
white and brown piliform scales. The frons 1s smooth with broad whate scales that are
heavily suffused with brown. The antennae are grey with a single row of scales
encirching each segment. The length of antennae are roughly 0.8x that of the forewing.

The labial palpus 1s mostly white and light to dark brown laterally (Davis 2001).

Source: Dawis (2001)
Figure 6 - P. nipigon adult forewings; 30, 4.3 mm in length; 31, 3.7 mm in length.

The thorax of the adult moth has a mostly white dorsum, speckled with dark
brown tipped scales. Venter 1s white and the forewing 1s vanable — pale reddish to
bronzy brown and usually with five white bands extending across wings that fuse with
four broader white dorsal bands. Dorsal bands are reduced and usually separated by
reddish brown bands. The whate bands are usually speckled with dark brown. The wing
fringe 15 pale grey, and the hindwing and fringe are uniformly pale gray as well. The
legs are dark preyish brown dorsally, white ventrally, and the apices of tibial and tarsal

segments are shightly lighter in colour (Dawvis 2001).
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The abdomen 1s greyish brown dorsally and white ventrally. Any conspicuous
sex scaling 1s absent. The eighth sternum of males 15 elongate and gradually tapers
caudally to an acute apex. Male gemitalia (Figure 7) have a slender vinculum tapening to
a moderately elongate saccus. Transtilla are slender. Valva 1s symmetrical, elongate and
slender, tapering to a nearly straight and downcurved acuminate apex The aedeagus 1s
slender with a small subabical lobe and 1s relatively short — 0.65-0.7x the length of the
sternum Female genitalia can be described as having an accessory bursa with an
elongate duct equalling the length of ductus bursae and ansing from a short and shghtly
enlarged common duct (antrum) immediately anterior to the ostium. There 15 a common
duct with a small and narrow sclerotized ring. The signum 1s a single elliptical to

pyriform hightly sclerotized disk bearing a single pair of minute papillae (Davis 2001).

(Davis 2001}

Figure 7 - P. nipigon: male and female genitalia. 239, full view, male; 240, aesdoeagus; 427, lateral view, female; 428,
lateral view, female.
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Damage

Phyllonorycter species create full depth blotch mines between the upper and
lower layers of leaves belonging to the host tree. Figure 8 shows the anatomy of a full
depth mune on a leaf. A cross section of a leaf can be split mnto four layers: cuticle,
epidernus, palisade parenchyma, and spongy parenchyma. Palisade parenchyma 1s found
just under the upper surface or cuticle of a leaf, below the epidermus, and 15 made of
tightly packed cylindrically shaped cells to which 1t owes its name_ Below the palisade
parenchyma and just mside the outer surface of the leaf lies a layer of loosely packed
cells called the spongy parenchyma. Full depth blotch mines created by the Gracilarndae
(Figure 9), which includes more specifically the genus Phyllonorycter, begin within the

epidermal layer of a leaf and later progress to the parenchyma (Herning 1951).

-
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Source: Hening (1951) Source: Davis (2001)

Figure 8 - Cross section of a full depth mine. {C - cuticle, Figure 9 - Leafimines of P. mipigon on balsam poplar

E- epidenmus, P - pahsade parenchyma, 5 - Spongy parenchyma)
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Potential relationships between leaf area and the number of eggs laid on the
surface of the leaf have been suggested for leaf-miming moths that create linear mines
Lithocolletis quercus and Stilbosis quadricustatella, finding that both species tend to lay
eggs on leaves with larger surface areas. In the case of L. quercus, however, leaf area
explamed only 9-29% of vanation in mune density (Auerbach 1989). Also of note 1s that
m the case of S. quadricustatella larger leaves were found to have more mines than
smaller leaves on average, though there was no correlation between distributions of leaf
size between trees and mine densities (Simberloff 1987). The same was found for
another study on Scolioneura betuli, also leaf miner, where 1t was found that there was a

higher number of larvae on leaves with larger leaf areas (Tuomu 1981).
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METHODS
LEAF SAMPLING AND MEASUREMENTS

This study began with the collection of sets of leaves from infested trees for
mspection of leaf blotch mines. Leaves were haphazardly collected from balsam poplar
and trembling aspen frees less than 10 m in height on the Lakehead Unmiversity Campus
on August 15% 2018 Leaves were placed in Ziploc bags, labelled, and then frozen for
later inspection. Imtially, 100 leaf samples were selected from each of 5 different trees —
2 tremblmg aspen and 3 balsam poplar. These first 500 leaf samples were then assessed
for the number of leaf blotch mines per leaf. The resulting leaf blotch counts were then
entered mto a database so that different statistical analyses could be performed.
Exanuning leaves of each tree species, and then determuning the number of leaf botch
nmunes per leaf, the 100 leaf samples per tree produced data that would then be
manipulated to determine 1f there were any differences between the number of leaf

blotch mines on a balsam poplar or a trembling aspen.

The potential relationship between leaf surface area and the number of leaf
blotches per leaf was investigated based on examination of 50 leaf samples from one of
the balsam poplar trees and 50 leaf samples from one of the trembling aspen trees. Leaf
area was measured using two tools: an online service called SketchAndCalc and an
mmage processing program (Image]) designed for scientific analysis of multidimensional

mmages.
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SKETCH AND CALC

To measure leaf area using SketchAndCalc leaves were placed on a lightboard and

photographed alongside a measurmng tape for scale (Figure 10).

Figure 10 - balsam poplar leaf sample agamst lightboard next to measure used for scale

Images were then uploaded to the SketchAndCale service where the measuring

tape was used as a reference to assign a scale to the image (Figure 11).

Figure 11 - assigning scale to SketchAndCalc
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From here, leaf margins were traced using the free draw too. Once completed a

surface area was generated for that leaf (Figure 12).

Figure 12 - leaf margin has been traced and surface area calculated

This process was repeated for each of the 50 leaves selected for both the balsam
poplar and trembling aspen sample trees. Results would then be compared to those

achieved through Image]J software for the same leaves.
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IMAGEJ

Image]J, an open source, free image processing program (https://image] nih gov/1}/)

was used next. A new set of images was taken of the same set of leaves to be used for
processing and measurement through ImageJ. The result of re-taking the images for a
second measurement was a shuffle of the leaves and as such the leaves are the same, but
leaf numbers were assigned differently among the samples. The new set of images was
taken using a scanner on a white background with a circular sticker measuring 635 cm
m the corner for a scale reference (Figure 13). Each leaf was placed on the same
background and scanned, producing a catalogue of all 50 leaf samples for each balsam

poplar and trembling aspen.

Figure 13 - balsam poplar sample scanned with calibrated 0.635 cm "dot’ in comer


https://imagej.nih.gov/ij/

17

The 1mage was opened in Image]J and converted to 8-bit for analysis (Figure 14).
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Figure 14 - converting to 8-bit in Image]
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Zoomng 1n on the scale dot, the straight line tool was used to measure from the
farthest visible pixel on either side (Figure 15). Using the Analyze tab and the Set Scale
function the distance measured 1s given in pixels - in this case the dot 1s 38 pixels wide

and a known distance of 0.635 cm can be assigned.

File Edit Image Process Analvze Plugins Window
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Figure 15 - using the scale dot to assign a scale to the image
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Next, using the Edit tab and Options, colours were set to make the background
white and the foreground black. Under the Image tab and Adjust, the Threshold function
was selected and default values were changed using the automatic setting. Automatic
setting was selected to avoid any bias in image processing by the user. Once the image
has had the threshold balanced, all shadows are eliminated from the leaf margin and the

results were a black and white outline of the leaf area (Figure 16).
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Figure 16 - adjusting image threshold in Image]
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Next, using the magic wand tool, the leaf 1s selected and margins are highlighted

yellow. Under the Edit tab, the fill tool 1s used and the leaf 1s filled in (Figure 17).

& Image)

File Edit Image Process Analyze Plugins Window Help

Ol <4 [s=l Ala|®| 2| Qfow| 4| &)
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Figure 17 - selected image has been filled using both magic wand and fill tools
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The final step in this process 1s using the Analyze tab and clicking Measure. In the

case of this leaf a surface area of 24 432 cm” has been calculated (Figure 18).

i Imagel = =

File Edit Image Process Analyze FPlugins Window Help
o ||~ 48 ala|o| 2] ol s|a| x| |

File Edt Font Resulis

larea [mean [min [wax | j

1 24432 0 o0
&

Figure 18 - leaf area measured at 24 432 cm?

Agam, this process was repeated for the 50 leaves in each set for the selected

balsam poplar and trembling aspen frees.
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STATISTICAL ANALYSES

All data was entered into Microsoft Excel for statistical analysis to be performed;
determiming the distribution of leaf blotch mines in both balsam poplar and trembling
aspen, if there 15 a difference in the number of leaf blotch mines between balsam poplar
and trembling aspen, if there is a linear relationship between leaf surface area (cm?®) and
the number of leaf blotch mines present, and if one of the tools used to measure leaf

surface area (cm?) is better suited to this application than the other.

Frequency distributions for the number of leaf blotch mines per leaf were
generated for the imitial 500 leaf samples, looking at the occurrence of the number of
leaf blotch mines per leaf across all sample trees. Regression analyses were then
performed comparing leaf surface area (cm’) and the log-transformed number of leaf
blotch mines present for the 100 sample leaves that had been used for leaf area analysis,

using both ImageJ and SketchAndCalc.

T-tests (two-tailed, to.025) were used to test for the occurrence of sigmficant
differences in the: 1) average number of mines per leaf on balsam poplar and trembling
aspen, , 11) leaf surface area of balsam poplar and trembling aspen, and 111) leaf surface

area measured using ImageJ and SketchAndCalc softwares.
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RESULTS

Results of the investigation into leaf blotch nune distribution across 2 trembling
aspen trees and 3 balsam poplar trees, involving 100 leaves sampled from each subject
tree, found that there was an average of 4.41 mines per leaf for balsam poplar and an
average of 3.93 munes per leaf for trembling aspen. A t-test using the log-transformed
data from the 100-leaf sets of two balsam poplar and two trembling aspen trees yielded
no significant difference in the average number of mines per leaf on either tree species
(Ho: no significant difference between number of mines between tree species, to.o2s df =
199, t=-1.36, p=0.18, FTR Hy).

Table 1 - t-test of average leaf blotch mine count for both tree species

Null Hypothesis: No difference in average number of leaf blotch mines on each tree species

t-test: Paired Two Sample for Means

Trembling Aspen Balsam Poplar

Mean 0.655185617 0.6821441
Variance 0.036734975 0.048867025
Observations 200 200
Pearson Correlation 0.082378477

Hypothesized Mean [ 0

df 199

t Stat -1.35968032

P(T<=t) one-tail 0.08773326

t Critical one-tail 1.652546746

P(T<=t) two-tail 0.17546652

t Critical two-tail 1.971956544

P=0.1754 > 0.025

t<tCrit=FTR

No significant difference
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The frequency distribution of the occurrence of leaf blotch mines (1,2,3 mines etc.)
on all trembling aspens and all balsam poplars was generated and 1t was found that the

number of attacks followed a poisson distribution (Figures 19-25).

Frequency of Leaf Mines Across All Balsam Poplars
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Figure 19 - listogram displaying the frequency of the number of leaf blotch mines across all balsam poplar samples
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Figure 20 - histogram displaying the frequency of the number of leaf blotch mines in balsam poplar sample 1
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Frequency of Leaf Mines in Balsam Poplar 2
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Figure 21 - histogram displaying the frequency of the number of leaf blotch mines in balsam poplar sample 2
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Figure 22 - histogram displaying the frequency of the number of leaf blotch mines in balsam poplar sample 3



26

Frequency of Leaf Mines Across All Trembling Aspens
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Figure 23 - histogram displaying the frequency of the number of leaf blotch mines across all trembling aspen samples
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Figure 24 - histogram displaying the frequency of the number of leaf blotch mines in trembling aspen sample 1
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Frequency of Leaf Mines in Trembling Aspen 2
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Figure 235 - histogram displaying the frequency of the number of mines leaf blotch in trembling aspen sample 2

Using the online service SketchAndCalc it was found that the average leaf area
for balsam poplar trees was 25 43 cm’, compared to an average area of 12.05 cm? for
trembling aspen. When a t-test was performed a signmficant difference was found mn leaf
areas between the two tree species (Ho: no significant difference between leaf areas of
etther species, tg 25 df =49, t =8.5, p < 0.00001, Reject Hp).

Table 2 - t-test of average leaf surface area (cm2) in balsam poplar and trembling aspen - SketchAndCale

Null Hypothesis: no significant difference between leaf areas (cm2)
in balsam poplar and trembling aspen
t-test: Paired Two Sample for Means

Balsam Poplar  Trembling Aspen

Mean 25.4284 12.049
Variance 74.18145861 23.76752347
Observations 50 50
Pearson Correlation -0.308347358

Hypothesized Mean Difference 0

df 49

t Stat 8.501289727

P{T<=t) one-tail 1.65222E-11

t Critical one-tail 1.676550893

P{Te=t) two-tail 3.30444E-11

t Critical two-tail 2.009575237

P < 0.00001 < 0.025

t>tCrit = REJECT
Significant difference
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A regression analysis was performed using the data of leaf surface area and the

number of leaf blotch mines present per leaf for all 50 leaves each of balsam poplar and

trembling aspen. A linear relationship was found between leaf area and the number of

leaf blotch mines for both tree species (Figures 26, 27).

Leaf Area (cm?) and Leaf Blotch Mines per Leaf - Balsam Poplar 3
(SketchAndCalc)
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Figure 26 - scatter plot displaying leaf area (SketchAndCalc) and the number of mines per leaf for balsam poplar 3,
number of nunes per leaf has been log transformed

Table 3 - regression statistics: balsam poplar leaf blotch mines per leaf and leaf surface area (cm”) - SketchAndCale

Regression Statistics
Multiple R 0.604708371
R Square 0.365672215
Adjusted R Square  0.352457052
Standard Error 0.189930242
Observations 50
ANOWVA
df 55 MS F Significance F

Regression 1 0.998177343 0998177 27.67066 3.30414E-06
Residual 48 1.73152785 0.036073
Total 49  2.729705193

Coefficients Stondord Error | Stat Pvalue  Lower95%  Upper 95% Lower 95.0% Upper 95.0%
Intercept 0.190090587  0.084489713 2249867 0.022079 0.020212633 0.359968542 0.020212633 0.355968542
X Varlable 1 0.016571359 0.003150274 5260291 33E-06 0.010237308 0.022905411 0.010237308 0.022905411
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Leaf Area (cm?) and Leaf Blotch Mines per Leaf - Trembling Aspen
2 (SketchAndCalc)
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Figure 27 - scatter plot displaying leaf area (SketchAndCalc) and the number of mines per leaf for trembling aspen 2,
number of nunes per leaf has been log transformed

Table 4 - regression statistics: trembling aspen leaf blotch mines per leaf and leaf surface area (cm?) - SketchAndCale

Regression Statistics
Multiple R 0.383052878
R Square 0146729507

Adjusted R Square  0.12895303%
Standard Error 0.215656425

Observations 50
ANOWVA

df 55 M5 F Significance F
Regrassion 1 0.383881137 0.383881 8.254143 0.00603875
Residual 48  2.232359295 0.046508
Tatal 49  2.616250432

Coefficients  Stondard Error £ 5Stat  P-value  Lower 95%  Upper 95% Lower 95.0% Upper 95.0%
Intercept 0.32531257 0.082022768 3.966125 0.000243 0.150394741 0.490230399 0.1603%4741 0.490230399
X Variable 1 0.018155507 0.00631935 2. 873002 0.006039 0.005449603 0.030861411 0.005449603 0.030861411
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The second method of leaf area measurement, using the program ImageJ, found
similar results. Using the same leaves sampled for the SketchAndCale analysis it was
again found that balsam poplar had a sigmificantly larger average leaf area than
trembling aspen, with balsam poplar having an average area of 24 26 cm* compared to
11.16 cm? for trembling aspen (Hy: no significant difference between leaf areas of either

species, tpo2s df =49, t=8.5, p < 0.00001, Reject Ho).

Table 5 - t-test of average leaf surface area (cm2) in balsam poplar and trembling aspen - Image]

Mull Hypothesis: no significant difference between leaf areas (cm2) in

balsam poplar and trembling aspen
t-Test: Paired Two Sample for Means

Balsam Poplar Trembling Aspen

Mean 24.25798 11.1601
Variance 67.35444639 20.68932964
Observations 50 50
Pearson Correlation -0.001815008

Hypothesized Mean Difference 0

df 49

t Stat 9.862856749

P(T<=t) one-tail 1.58875E-13

t Critical one-tail 1.676550893

P(T<=t) two-tail 3.1775E-13

t Critical two-tail 2.009575237

P < 0.00001 < 0.025

t=tCrit = REJECT

Significant difference
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A regression analysis was preformed using the data of leaf surface area and the

number of mines present per leaf for 50 leaves each balsam poplar and trembling aspen.

A linear relationship was found between leaf area and the number of leaf blotch mines

for both tree species (Figures 28, 29).
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Figure 28 - scatter plot displaying leaf area (ImageJ) and the number of mines per leaf for balsam poplar 3, number of
mines per leaf has been log transformed

Table 6 - Regression statistics: balsam poplar leaf blotch mines per leaf and leaf surface area (cm2) - ImageJ

Regression Statistics
Multiple R 0.671278243
R Square 0.450614479
Adjusted R Square  0.439168947
Standard Error 0.176781705
Observations 50
AMNOVA
df 55 M F  Significance F

Regression 1 1.230392865 1.230393 39.37034 5.5318E-08
Residual 43  1.500085011 0.031252
Total 49 2730477876

Coefficients Standard Error  t5tot  P-value  lower 95%  Upper 95%  Lower 95.0% Upper 95.0%
Intercept 0.142783052 0.078722102 1.813761 0.075968 -0.015458343 0.301064448 -0.015458343 0.301064448
X Variable 1 0.019308153  0.003077203 6.274579 5.53E-08 0.013121022 0.025495284 0.013121022 0.025495284

45
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Comparison of Leaf Area (cm2) and Mines per Leaf - Trembling
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Figure 29 - scatter plot displaying leaf area (ImageJ) and the number of mines per leaf for trembling aspen 2, number
of mimes per leaf has been log transformed

Table 7 - Regression statistics: trembling aspen leaf blotch mines per leaf and leaf surface area (cm?) - Image]

Regression Statistics
Multiple R 0.329499076
R Square 0. 108569641
Adjusted R Square  0.089993175
Standard Error 0.208063347
Observations 50
AMNOVA
df 55 M5 F Significance F

Regression 1 0.25307741 0.253077 5.846046 0.019457419
Residual 48  2.077937107 0.04329
Total 49  2.331014517

Coefficients Standard Error  t5tat Pvalue  Lower 95%  Upper 85%  Lower 95.0% Upper 95.0%
Intercept 0.3731606597 0.078540029 4745175 1.91E-05 0.215044322 0.531277072 0.215044322 0.531277072

X Variable 1

0.01579934 0.0D653468

241786 0.019457 0.002661085 0.028938795 0.002661085 0.0ZB53E795

25
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A t-test performed comparing SketchAndCalc and ImageJ for the purpose of

leaf area measurement yielded no significant difference between the two methods for

this application (Ho: no sigmificant difference between either method of leaf area

calculation for balsam poplar, to.o2s df =49, t=-0.8, p = 0.45, FTR Hp; Ho: no significant

difference between either method of leaf area calculation for trembling aspen, to025 df =

49, t=-0.98, p=0.33, FTR H).

Table 8 - t-test of average leaf surface area (cm2) found for both tree species using SketchAndCalc and Imagel

Mull Hypothesis: There is no difference between either method in measuring surface area for either tree species

Balsam Poplar
t-Test: Paired Two Sample for Means

Imagel SketchAndCale
Mean 2425798 254284
Variance 67.35444639  74.18145861
Observations 50 50
Pearson Correlation 0.153213126
Hypothesized Mean D 0
df 49
t Stat =0.755893545
P(T<=t) one-tail 0.226665853
t Critical one-tail 1.676550893
P(T<=t) two-tail 0.453331706
t Critical two-tail 2.009575237
P=0.453 >0.025

t<tCrit = FTR
Mo significant difference

Trembling Aspen
t-Test: Paired Two Sample for Means

Imagel SketchAndCale

Mean 11.1601 12.049
Variance 20.68932964  23.76752347
Observations 50 50
Pearson Correlation 0.075935799
Hypothesized Mean ]
df 49
t Stat -0.98056109
P(T<=t} one-tail 0.165813023
t Critical one-tail 1.676550893
P(T<=t} two-tail 0.331626046

t Critical two-tail 2.009575237

P=10.332 >0.025
t<tCrit = FTR
Mo significant differance
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DISCUSSION

The distribution of leaf blotch mine occurrences on sample leaves was found to
correspond to a poisson-type pattern (Figures 19 - 26). This result 1s in confrast to
studies conducted by Auerbach (1989) and Simberloff (1987) who found that leaf mines
created by Lithocolletis quercus and Stilbosis quadricustatella did not follow a poisson
type pattern — However, Auberbach and Simberloff studied linear leaf mines and not leaf
blotch mines, which may account for the differences between studies. Regression
analyses for both trembling aspen and balsam poplar suggest a positive linear
relationship between leaf area and the number of leaf blotch mines on each leaf, with a
greater leaf area relating to a higher number of mines. These findings are supported by
several other studies mn which positive linear relationships were also found between leaf
area and the number of leaf blotch mines present (Auerbach 1989, Simberloff 1987,
Tuonmu 1981). The relationship between leaf area and number of leaf blotch mines
suggests that adult female P. nipigon possibly select leaves with more tissue available
for larvae to feed on. If several eggs were to be deposited on a smaller leaf, 1t may be
more likely that these larvae might not survive or have reduced survival due to
mtraspecific competition.

Comparisons of trembling aspen and balsam poplar leaf areas showed that balsam
poplar has | on average, a much larger leaf area than trembling aspen. It 1s interesting to
note that, while a significant difference in leaf size was found between the two tree
species, and a positive linear relationship between larger leaf area and more leaf blotch

mines was found, the average number of leaf blotch mines on either tree was not found
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to be significantly different. This could suggest that female P. nipigon moths tend to
oviposit on host leaves in an opportunistic manner. If a female lands on a trembling
aspen, she may simply select larger leaves to lay eggs on, as opposed to trying to find a
balsam poplar host tree, given that they have larger leaves on average. Alternatively, the
poisson-distributed pattern of leaf blotch mines suggests that female moths select leaves
at random, with some leaves ending up with numerous mines, while a few leaves escape

attack completely.

A comparnison of the two methods of measuring leaf area found that both
SketchAndCalc and Image]J were appropnate tools for measuring balsam poplar and
trembling aspen leaf areas, as there was no significant difference found between the leaf
area data provided by the two methods. SketchAndCalc did find, on average, larger leaf
areas. This was likely due to the potential for measurement error when tracing leaf
margins, as it would take meticulous care and effort to trace each serration on the leaf
margin. ImageJ nutigates this 1ssue through balancing the image thresholds and
automatically highlighting the borders of the leaf — including each serration on the leaf
margin. While the 1ssue of an exaggerated border through leaf area measurement when
using SketchAndCalc does exust, it was not found to be of sigmficance for the purpose
of this study. It 1s important to note, however, that both of these methods assume that

any damage to the leaf margin occurred prior to oviposition on the leaves.

Other 1ssues discovered that may skew leaf areas was the potential folding or
curling of leaves. This 1ssue was nutigated when scanming leaves for Image], as the hid
of the scanner flattened leaf surfaces, elininating any folds present. When

photographing leaves for SketchAndCalc 1t would have been beneficial to press the
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leaves between the lightboard and a transparent surface, such as a glass plate, effectively
removing any folds in the leaf. Perhaps the optimal method of measuning leaf area would
be through the use of a L1-Cor leaf-area meter. This tool uses a two-belt system, feeding
leaves between the transparent belts using a roller which flattens them, elinunating any
curls present. This tool is accurate to 0.1 mm? and has been used to measure leaf area in

similar studies (Auerbach 1989).
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CONCLUSION

The two tools used for measuring leaves in this study are both viable means of
estimating leaf surface area to a hugh degree of accuracy. While SketchAndCalc was
found to have higher estimates of leaf area, it was not significant enough to have a major
mpact on findings. Mine frequency distributions across all sample trees followed a
poisson-distributed pattern and a positive linear relationship between leaf surface area
and number of leaf blotch mines present were found, with larger leaves more likely to
have a higher leaf blotch mine count. There was not a signmificantly larger presence of
munes on the tree species with larger leaves (balsam poplar) — suggesting that
oviposition by adult female P. nipigon moths occurs in an opportunistic manner. Future
studies could exanune potential effects of P. nipigon outbreaks on balsam poplar and
trembling aspen growth, as evidenced by reductions in radial growth due to a loss of

photosynthetic area.
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APPENDIX A

Leaf blotch nune frequency, distribution, and leaf surface area data

Table 9 - Leaf mine counts across all sample trees
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Table 10 - Log transformed data, leaf blotch mine counts across all sample trees
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Table 11 - Leaf blotch mine frequency distributions, total or both species and across each sample tree

Pt B
Miine Count] Frequency Mine Count ] Frequency
o 4 o 12
1 13 1 18
2 3 2 36
3 35 3 5]
4 ag 4 44
L] a7 L] 42
& ) & n
T 10 T Fal
g L] g Fal
5 o 5 12
10 2 hli] 2
11 o 11 2
12 o 12 2
13 o 13 i
14 [i] 14 2
Bpl Bp2
Mine Count] Frequency Mine Count | Frequency
i} 2 o 3
1 g 1 &
F L] 2 18
3 17 3 »
4 15 4 H)
-1 20 L] 9
& T & &
7 5 T 4
& T g 4
] T 5 2
10 o hli] 1
11 o 11 1
12 2 12 i
13 o 13 i
14 1 14 1
Bp3 Pl
Miine Count] Frequency Mine Count ] Frequency
i} T o i
1 4 1 4
F 13 2 14
3 17 3 15
4 14 4 n
-1 13 L] F-
& 5 & 13
7 g T 3
& 10 g 3
] 3 5 i
10 1 hli] i
11 1 11 i
12 o 12 i
13 o 13 i
14 [i] 14 i)
P2
Mine Count] Frequency
i} 4
1 5
F 20
3 20
4 16
-1 11
& 5
7 T
& 2
] o
10 2
11 o
12 o
13 o
14 ]




44

Table 12 - Leaf surface area results using SketchAndCalc method for two sample trees

Balzam Poplar 3 | | Trembling fspen 3
Leaf Sample No Surface Area (cmd) Mines Blinaes - an Leaf Sample No Surface Area jcmid) Mines  |Mines -mﬂ
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19 26.43 4 i 15 1542 -1 Ll ]
m 2632 3 LBl 0 153 ] 0es
Fal 26.11 -1 o il 13.63 3 L&D
n 11.05 2 o.ag n 15.54 2 48
] 3434 4 i n a5 1 030
F- ] 2061 2 o.ag 4 11.17 1] od
» 40,01 3 LBl 5 a4} 3 L&D
F. ] 42.40 ] 1.00 6 423 1 030
x 2067 3 LBl 7 195 3 L&D
F- ] 15.23 -1 o F- ] 10,03 -1 Ll ]
F] 21.85 4 i 9 a4 2 48
n 15.2 2 o.ag 30 sa7 1 030
n 15.54 1 030 1 13.8% 4 i)
kv 19.62 4 i an 11.18 4 i)
k<] 21.65 3 LBl 13 14.37 -1 Ll ]
-] 16.44 [ 0.85 34 14.19 7 050
k-] 42 85 a 055 a5 56 3 L&D
E 1671 3 LBl k) 2035 7 050
7 2nm [ 0.85 a7 1212 4 i)
k-] 411 -1 o g 186 4 i)
k-] 2516 -1 o 5 195 1 030
40 12.14 2 o.ag 40 k] 1 030
41 4257 4 i 41 84 3 L&D
42 17.69 [ 0.85 42 16& 1 030
43 20.45 1 030 43 il | 2 48
44 034 [ 0.85 a4 10,54 2 48
4% 40,47 [ 0.85 45 1158 1 030
46 .04 -1 o 46 1382 ] 0es
47 EER ] -1 o 47 19.84 7 050
4% 25.76 2 o.ag 48 11.48 2 48
49 A -1 o 45 599 2 48
&0 2966 & 085 50 12.34 4 i)
Average 25.43 162 Average 12.0% 298
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Table 13 - Leaf surface area results using Image] method for two sample trees

Bal Poplar 3 |
Leaf Sample Mo |Surface Area {cm2) Mines  [Mines - Loglx+1)

1 2645 1 0.30
3 ELS E 0.85
3 1455 1 0.30
4 2695 El CLBD
5 2601 5 ore
3 o84 [} 000
7 10.46 2 048
L 3418 4 oz
8 4224 5 ore
10 20,09 2 048
1 17.80 2 048
12 1515 1 0.30
13 2692 E 0.85
14 210 El CLBD
15 14.09 2 048
16 2213 5 ore
17 23.02 4 oz
18 20.30 4 oz
18 23.02 El CLBD
20 17.41 1 0.30
21 2837 E 0.85
22 27.43 2 048
23 2382 2 048
24 2641 2 048
25 30.25 5 ore
25 39,34 9 1.00
27 2857 El CLBD
28 24 56 El CLBD
29 17.10 1 0.30
Eli] 1565 [} 000
a1 1132 [} 000
az 21.20 El CLBD
a3 3158 4 oz
£ 26.74 E 0.85
LY 30.24 E 0.85
1] 26,48 4 oz
az 10.42 2 048
g 2248 5 ore
ag 40.36 4 oz
40 3818 4 oz
41 2265 4 oz
4z 20.7% 4 oz
43 3E.31 9 1.00
a4 3448 E 0.85
45 3252 5 ore
45 16.44 El CLBD
47 ETiE:5 § E 0.85
48 1561 E 0.85

1829 El CLBD

2111 4 0.70

Average 24.26 3162

Trembling Aspen 2

Leaf Sample No

Surface Area [cml)]

Blines | Bines - Lngxi-l'l

1 14,60 5 i
2 826 5 i
El 13.76 1 Q.30
4 10.33 2 048
5 5.04 1 Q.30
E 1811 1 Q.30
7 17.62 El QB0
2 14,63 2 048
9 140 1 Q.30
i1} 17.82 El QB0
11 1312 5 i
12 13.30 2 048
13 o492 [} Q.00
14 10.65 [} Q.00
15 4.05 1 Q.30
1E 866 4 o
17 1.3 4 o
18 m El QB0
15 5.80 El QB0
Fi] B.61 2 048
21 1243 1 Q.30
22 13.27 2 048
23 155 1 Q.30
24 1495 7 .80
25 1470 El QB0
2B 16,53 El QB0
27 1401 2 085
28 16.16 El QB0
29 15,19 1 Q.30
k] 11.60 4 o
a1 13.48 5 i
a2 11.14 2 048
a3 18,14 2 048
EL 336 2 048
EL 740 El QB0
E 1467 El QB0
a7 715 El QB0
ag .36 2 048
ag a8 1 Q.30
a0 1171 4 o
41 5.76 2 048
42 1201 El QB0
43 18,61 7 .80
44 13.08 7 .80
45 335 1 Q.30
45 385 2 048
47 10.59 4 o
48 10.50 4 o
45 E.80 5 i
50 19,24 B 0.85
Average 11.16 2.58
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Appendix B

Catalogue of sample leaves for surface area analysis — ImageJ — balsam poplar
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APPENDIX C

Catalogue of sample leaves for surface area analysis — ImageJ — trembling aspen
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APPENDIX D

Catalogue of sample leaves for surface area analysis — SketchAndCalc — balsam poplar
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APPENDIX E

Catalogue of sample leaves for surface area analysis — SketchAndCale — trembling aspen
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